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Microsoft Frontpage - The Basics  

Microsoft FrontPage is a user-friendly and relatively powerful WYSIWYG webpage editor (meaning, what 
you see is what you get).  Georgetown University offers classes on FrontPage.  If you are interested in 
signing up for these FREE courses, go to http://data.georgetown.edu/training.  This page is designed to be 
a supplement to this training course and to provide beginning web page designers a feel for the basics of 
the program.  After completing all of the segments of this FrontPage guide, you will be equipped to create a 
website and add text, images, links, and tables.  
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Before you Start 

Before you begin writing web pages, you should be familiar with Internet terms, have an MSB account, and 
know how to browse the World Wide Web with Netscape or Internet Explorer. You should be comfortable 
using Microsoft Windows and have word-processing experience, particularly MS Word. Finally, it's best if 
you know how to manage your files, including how to move a file from one directory or folder to another on 
your own computer or a network. 

To begin creating your website, you'll need to follow these steps: 

1. Request your web space through https://intranet.msb.edu/student/create/request.ssi  
2. Make sure you have a W: drive when you log in. It will be "student/context/username (W:)" when you 

look in "My Computer." (ie: student/u03/hoyaj)  
3. Save a draft of your webpage as index.html to your folder on the W: drive.  When you have web 

space created, we place templates in your folder for a very basic web page and resume.  
4. Test your page by opening it with available browsers.  View your page at 

student.msb.edu/context/username/ (example: http://student.msb.edu/u06/hoyaj/). 
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Getting Started 

Microsoft FrontPage is a part of some Microsoft Office packages, which are available to purchase at a 
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number of locations including the Georgetown Bookstore, or is available for use free within MSBTC 
computer labs.  To start, open Microsoft FrontPage from its location on the start menu or the desktop.  
When the program starts, click on the file menu - click new - then choose page or web... 

 

You have three options of creating a new webpage.   

� Blank Page - Create a page from scratch 

� MSB Template - You can find templates on the MSB Student Templates page.  They are also saved 
under your W: drive.  

� FrontPage Template - You can select from a host of templates with common page designs, as 
shown below.  To access these, click on page templates on the right hand side of the page after 
clicking file - new - page or web. 
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Overview of FrontPage 

Within FrontPage itself, there are three different methods of viewing your page.  These are "normal," 
"HTML," and "Preview."  As you may know already, HTML is the actually coding language used to create 
websites.  If you click on this tab you will see the code that actually forms your website and is "read" by web 
browsers such as Netscape and Internet Explorer.  For the purposes of this guide, only the normal and 
preview buttons are important.  All changes to your page will be done in "normal" view.  You can test how it 
will look within Internet Explorer by using the "preview" button. 

FrontPage allows you to open multiple documents, letting you edit several related pages simultaneously or 
compare differences between them.  You can switch between files with the tabs above the page, and 
between the Normal, HTML, and Preview views with the tabs below the page. 
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Saving Your File 

To save your file, choose Save from the toolbar. If this is your main home page, name it index.htm; 
otherwise, it can be anyfile.htm. ".htm" is short for "HTML," which stands for hypertext markup language, 
the language read by Web page browsers.  

What's in a name? The importance of being index.html  

If you call your main page index.htm, browsers can get to your page with the standard URL for pages on 
the MSB Website: http://student.msb.edu/userid/. Using index.html makes your folder more convenient and 
more secure. If you do not have a file called index.html in your W: drive, users who type the standard URL 
will see a list of your files and folders instead and can look through them to their hearts' content. The 
address of other files in your W: drive is http://student.msb.edu/userid/filename.htm.  
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Building Content 

Copying Information from Your Existing Documents  
Many people want to put existing documents on the Web. One method for doing this is to open the 
document in a word-processor, select and copy some text, switch to FrontPage, and paste it into your Web 
page. You can also save a document as HTML in Microsoft Word by selecting file - and choosing Save as 
Web Page. Once you have done this, you can edit it in FrontPage.  
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Adding Text 

Initially, to add text all you need to do is click on the page while in the "Normal" viewing screen and begin to 
type.  We recommend (and you will probably find it convenient) that you use the different styles settings 
within FrontPage, such as the different Headings lists.  Selecting a style is shown below. 

 

Other general formatting settings can be changed just as they would be within Microsoft Word.  These 
functions include fonts, font sizes, bold, italics, text alignments, and a host of others. 

You can copy and paste text into your webpage easily from most other computer programs, including 
Microsoft Office products, such as Word and Excel. 

Back to top 

Adding Images 
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To insert an image into your website, click on Insert menu - select Picture - and choose From File.  At that 
point FrontPage will ask you to locate the file and select the picture you would like to insert.  Files ending 
in .gif and .jpg are ideal for websites because they were designed to download more quickly than other 
formats.  It is highly recommended that only these two file types be used.  If you would like more 
information on jpg and gif files, or on how to scan an image so it can be used on your website, check out 
our scanning tutorial.  

Clipart - Using Microsoft Clipart 

Microsoft offers a free clipart service that is both high quality and easy to use.  To insert clipart into your 
page, select insert - picture - clip art.  Click on "Clips Online" shown below. 

 

You can then search the Microsoft page for photos, clip art, and a variety of other resources that are well 
organized, and best of all, free. 
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Creating Links 

The internet as we know it is the interconnection of a huge number of sites and pages that create a "web" 
of information.  One of the most basic but important parts of creating a webpage is creating links within your 
own page and to other websites.  Creating links within FrontPage is quite easy.  There are essentially two 
different types of links - internal and external.   

An internal link is one that links to different points within the same page.  A very common implementation of 
internal links is a table of contents like the one at the top of this page, within which you can click on each 
section and be brought down the page to the correct heading for what you're looking for. 

An external link is one that connects your page to a different one, whether another of your files or someone 
else's.  This is by far the most common type of link.  Anytime you click on a link and are carried to a 
different page, as you did when clicking the link to get to this page from the list of training pages, you're 
following an external link. 

If you want to create an internal link, you must first select the part of the page that users will jump to when 
following the link.  To do this, select the title of the section you're linking to or simply click before the 
beginning of the text you wish to link to.  Click the Insert menu - and choose Bookmark (above "Hyperlink" 
in the image below).  Name it what you wish and click ok. 

To create any link, you should select the item(s) and/or text that you would like users to be able to click on 
to follow the link.  Once you've highlighted these, click the Insert menu - and choose Hyperlink or just click 
on the Hyperlink icon in the toolbar (both shown below) 

 

This should bring you to the screen you see below.  On the leftmost part of the window, you will see a list of 
4 different types of links - to existing files or web pages (external links), place in this document (internal 
links), create new document, or email address.   
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To complete an external link, copy and paste the http:// web address for the page you would like to link to, 
for instance, "http://www.yahoo.com/business".  If the page you're linking to is a different page of your web 
site, you can click on it in the main window portion of the screen and hit ok.   

To complete an internal link, select the bookmark that you've created and click ok.   

You can also create links which will send an email by clicking the email address link on the left side of the 
screen and entering your email address in the appropriate field.  Alternatively, you can use an email script 
through the MSB by creating an external link with /perl/email.pl?to=your_email@georgetown.edu as the 
address.  your_email@georgetown.edu should be replaced with your correct email.   
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Formatting with Tables 

Tables are the most commonly used method of formatting information on a web page.  They are very 
versatile and allow for a much more visually interesting site.  There are many advanced features within 
tables that can be used, but for purposes of a basic web page, you will only need to know how to create 
and adjust simple tables.   
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To insert a table into your document, click the Table menu - select Insert - and choose Table.  You will be 
given the option to select the number of rows (horizontal) and columns (vertical), then click ok.  You can 
now click inside each section of the table to create new content, add pictures, etc.  To resize each segment 
of the table, you can hold the cursor over the line dividing segments, then click and drag the line in the 
direction desired, creating different proportioned cells (pictured below) 

Page 9 of 11Microsoft Frontpage - The Basics

1/29/2007http://technology.msb.edu/training/Internet/FrontPage/index.htm



 

Once again, there are many more powerful functions available within tables, from exact cell sizes to 
merging and splitting cells to changing background colors.  Most of these functions can be found under the 
toolbar Table, and understood with a small amount of tinkering. 
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Signing and Dating your work 

You can put your email address on your page so that visitors can easily contact you with questions or 
comments. Provide either your email address only, or your email address with a link to a form readers can 
use to send mail directly from their browser to you.  

To add a link with your email address, first type a note like this toward the end of your page:  

This page last updated 12 November, 2002.  Maintained by your_email@address.com  

Select the email address itself and select the Insert menu - and click Hyperlink. address field, 
type /perl/email.pl?to=your_email@georgetown.edu and OK your change.  Alternatively, you can follow 
the instructoins described under "Creating Links" above to send email. 
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Publish Your Page on W:\ Drive 

To make your page available to the world, you must save it to your W: Drive under your folder.  

Overview of the Procedure  
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Check your page with a browser. If your files are on the campus Web server, your web page address is 
http://student.msb.edu/context/netid/  

Transfer your files to the W: drive using NetStorage (http://storage.msb.edu)  
If you are not connected to the MSB Network, you can transfer your files remotely by mapping a drive using 
NetStorage (Instructions).  

Check your page with a Browser  
As mentioned previously, if you call your file index.html, then your Web page address is 
http://student.msb.edu/context/netid/; look for other files at 
http://student.msb.edu/context/userid/filename.html.  

Potential Errors  
You may get one of the following error messages when you check your page:  

� 404 Not Found: Your browser cannot locate the file.  

You may have typed the URL incorrectly, or you may have named your file 
something different on accident.  

� Broken file icon: web browser does not recognize the graphic file.  

Check to be sure the files are saved in .gif or .jpg format and are in the same file 
location as when you first inserted it into your web page.  
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Where to Go From Here 

Now that you've created a basic and usable webpage, you can explore new ways of creating sites, 
formatting, and introducing style.  You can look at how other websites organize their data, you can take a 
class in HTML, or you can explore various websites with more extensive FrontPage tutorials than this.  
Also, you can always contact the MSBTC web staff at MSB-HELP@msb.edu for support on bringing your 
ideas to the web. 
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